Reference writing
using Endnote



Outline of session
Referencing — why is it so important?
Referencing systems: Harvard and Numerical

Citing references: exercise on referencing
different types of document and media (including
online)

Bibliographic software for reference and citation
(endnote)



Referencing — why is it so important?

e Established academic practice

 Shows where you got your information — well-
founded research

* Allows other researchers to trace your sources of
information quickly and easily

 Acknowledges the work of other researchers

* Protects you against accusations of plagiarism



Which system should | use?

Various different systems in use

Your journal to which you are writing may probably
advise you on which system you should use

If you are writing a paper for an academic journal, use
the house style that journal specifies

If there is no specific advice, choose one of the
University’s recommended schemes: Harvard or Numeric

Harvard probably most suitable for Health & Social
Sience subjects



Harvard system - citation

e Cite your sources within your text by giving the

— author’s surname(s),
— vyear of publication, and
— (when appropriate) page numbers:-

Eg.
James and Peters (2003, p.73) have argued that...

Contrary to popular perception, violent crime has been shown to
be decreasing (Johnson 2004, p.7)

For more examples see Guide to citing references under Harvard
System.



Harvard system - bibliography

e (Citations in the text refer to a full reference in the
bibliography

e All references are listed in author/date order:-

€g
HOLLAND, M., 2002. Guide to citing Internet sources [online]. Poole:
Bournemouth University. Available from:

http://www.bournemouth.ac.uk/library/using/guide to citing internet s
ourc.html [Accessed 4 November 2002].

OXFORD ENGLISH DICTIONARY, 1989. 2nd ed. Oxford: Clarendon Press.

UNESCO, 1993. General information programme and UNISIST. Paris: UNESCO,
(PGI-93/WS/22).

WISEMAN, S., ed., 1967. Intelligence and ability. Harmondsworth: Penguin.



Numeric system - citation

e Each citation in the text is given a number in
brackets:-

e Ericson (1) and Milne (2) take the view that... but
other authorities (3) argue that...

 References are listed in number order in the
bibliography, and cited by that number each time
they are referred to in the text.



Numeric system - bibliography

Example

1. ERICSON, E.E., 1991. The apocalyptic vision of Mikhail Bulgakov's
‘The Master and Margarita'. New York: Edwin Mellen, p.153.

2. MILNE, L., 1977 . ‘The Master and Margarita’: a comedy of victory.
Birmingham: University of Birmingham, pp.62-3.

3. BARRATT, A., 1987. Between two worlds: a critical introduction to
‘The Master and Margarita’. Oxford: Clarendon Press, p.96.

NB. Each reference number points to a single reference only



Reference management software

The software enables you to:
— download and store references

— include abstracts, keywords and notes with the references
— produce lists of references for yourself or others

— automatically insert citations of references while typing
(Cite While You Write)

— create a bibliography while typing (Cite While You Write)



EndNote




Who Can Use EndNote?

 Anyone writing an assignment, research paper
or thesis

 Anyone writing journal articles

 Anyone writing a book or a book chapter



What is an endnote?

It is a computer software that could arrange us a
reference.

A reference used during manuscript writing.

References could be written the way we want to
write.

We right references specifically, and endnote will
use reference writing style specific to the journal
we selected



Cont....

 EndNote is a software package which
allows you to store and organise your
references

 EndNote allows you to transfer references
into a Word document and automatically
creates a bibliography

* You can choose from a wide variety of
reference styles and easily change between
styles



Use of endnote

e EndNote is an online search tool

— it provides a simple way to search online bibliographic
databases and retrieve the references directly into EndNote.

e EndNote is a reference database

— it specializes in storing, managing, and searching for
bibliographic references in your private reference library.

e EndNote is a bibliography and manuscript maker

— it formats citations in Microsoft® Word with the cite while
you are writing



Starting Endnote

e To start the Endnote program and open a
sample library:
1. From the Start menu, choose Programs, select
Endnote, and then choose the Endnote Program.
'EndNnte'E .

mek Starked with EndMaoke 9

d] () Creabs a new EndMote library
—

@ () 5ee what's new in Endkoke 9

é? {?, Open an existing EndMoke library:

CHProgram Flest,  \Paleo.enl w | | Browse. ..

[ ] Do not dispiay this message again

[ oc [ coemt |




Cont...

2. Select ‘Create a new endnote library’ if new
library wanted, and ‘Open an existing EndNote
library’ if you want to browse existing
endnote.

3. To open the library, do one of these:

— Select *.enl in the drop-down list, and click OK.

— If *.enl does not appear in the drop-down list,

> Click the Browse button to locate it



Open

Laook. in:

PN

My Recent
Drocuments

|fr1}

Drezktop

=

by O ocuments

s

Iy Compuier

“

P Metwoik,

) Example:

) ¥

-

a‘:,

I Jpalen,Data
PPalen.enl

Filz narne:

Files of type:

e | Open

Libraries [*.enl.™ lib]

w | Cancel

17



Cont...

When you open the Paleo library, you will see the Library
window, listing all of the references that the library contains:

Move column dividers to adjust column widths

#4 Faleo.enl

Year © Title
Eolzmann's Constant (k)
1971 Waldezv. BElack
1974 Geophysical Fesearch Letters
1990 Mew Maxico Gealngical Society pl
1994 MNational Environmental Folicy Act .
1997  Exchange of ideas and information...  hitpifenergy
1992 Eocene fossils it dhenens C

1999 Sequnia BEcooyctern and Recreatin

2002 Personalities in Paleontology it e
Allen 1988 Modem-period muddy sediments ...
Alvarez 1984 Evidence from crater ages for peri...
Angell 1982 Relation of Antarctic 100 mb temp...

£

Mo References Selected

Showing 206 out of 206 references. 2 Hide Preview 18



Cont...

 You can sort by author, year, title or URL by
clicking on the column titles

 You are able to preview the reference by
clicking on the “show preview”

* You are also able to change to different style
of reference writing by drop down list of the
output style from the main tool bar.



Selecting and Opening a Reference

* To work with specific references you must first select
them in the Library window.

* You can find them by sorting or writing few words of
last name in the author column.

 Once you find the reference, you can open it by double
clicking it or by pressing enter

e When it is opened, it will show us details of the
reference including abstract (if it has URL)

* You can also see the PDF file if you have a PDF link



Cont....

After selecting a reference you can open it by clicking it or by shading and pressing enter

#|Paleo.enl EJEIE|

B Author Year | Title URL
1974 Geophysical Besearch Letters
1984 Matonal Emvronmental Policy Act
1990 MNew Mexico Geological Society pu..
2002 Personalities in Paleontolony http: funsns &
1999 Sequoia Ecosystem and Recreatio. .
1971 Waldezv. Elack

Allen 19858  Modern-period muddy sediments 1.
Ablarez 1984 Evidence from crater ages for peri ..
Angell 1988  Relation of Antarctic 100 mbtemp...
Apollonoy 1983 Batyrbay section, South Kazakhsta. .

Archaeo... Preliminary Site Report of the Crie. .

MNew paleantological excavation e

1. Argus, MY New paleantological excavation fechiniouess. Journal of
Faleontology, 1993 19 o 234237,
Showing 206 auk of 206 references, 2 Hide Preview

21



The title bar will show us last name of first author,
year of publication and record number

| Mminimize, maximize
litle ba : -- ’ |
| [ # Argus, 1991 ¥33 and close bultons
Frevious and Ne
Reference buttons '
— Reference Type list
Wrgus, Michele ¥
Miatthews , Edard K
seroll bar

Titls:
Title field { Sirafiarephic axcavation tachniquas for
paleantologists
J wrminl:
Joumal of Falenrtology
Yolume:
17

| o window comer

22



Entering References

* There are various ways to add references to an
EndNote library:

1. Type the reference information into the reference
window manually.

2. Connect to an online bibliographic database and
retrieve the references directly into EndNote.

3. Import text files of references that have been
downloaded from online bibliographic databases
or CD-ROMs



1. Manually

e Once a library is open, you can add a new reference to it:

1. From the References menu, choose New Reference (CTRL+N).

2. You can also click figure from the main toolbar

File Edit References Tools Wine Help - 0%
] == i % il W' @ Lwthor-Date x| 9



This menu comes

The reference may be a book, journal, internet browse, etc
select by drop downing the reference type

#1 Mew Reference [Palea.enl)

F aferanca Type |Jmumlﬁmdc

Reference Type
list

25



Cont...

You are now ready to enter the author’s names.

Author names can be entered

— “Last or middle, First” of each author

Individual author names must be entered one author per line.

Make a COIMIMA “, 7 after the first name
— Eg Abebe, Alemu

Getachew, Asaminew

Deyessa, Negussie

Then write the year, the title, volume, issue, page number, but
don’t use comma, parenthesis or other (other than in the name
of authors) (endnote will complete itself)

After completing, close by clicking the close batten



Example of a manually entered reference

¢ Deyessa, 1998 #29 =13

4m mp  FReference Type: | Joumal Aticle 4 Hide Empty Fields

Author A
Deyessa, Negussie

Kassaye, Mesfine

Demeke, BEerhanu

Taffa, Megussie

Year

1993

Title

Magnitude, type and outcomes of physical violence against married women in Butajira,
southern Ethiopia

Journal
Ethiop Med J
Volume

B8

Issue

2

Pages
23_07

27



2. Online bolographs.

To retrieve references from a remote database (internet), there
are five steps

1. From the Tools menu choose Connect and select the Connect
command fromxthe submenu.

EndMote 9 - violehge Copy.enl — 1 = e

File Edit References ols  Window Help

Qﬁ% & B & 21 O DD@@@' Autho

w w

[ VIOIENCE LopY.enl

B Author Year Title

Viatts 1995  The genogram: a new research tool to «
Tjaden 2000  Extent, nature and conseduences of inti
Subra... 2001 The prevalence and pattern of wife bea
Shimelis 1990 The history of Butajira town to 1974 [Se
Schuler 1999 Credit programs, patriarchy and men's
Odujinrin 1993 Wife battering in Migeria

MNasir 2003 Violence against pregnant women in de

4 m -

Reacly

[ 8



Procedure

Cite While You Wrike [CWYIN]

qubject Bibiography. ..
RTF Documenk Scan

Manuscript Templakes. ..

Qpen Term Lisks
Define Term Lists, .,
Limk. Term Lists...

Shiow Toolbar
Hide Previes

Configure Handheld Svnc. ..

Recover Library...

F

F

k|44
Chrl43

Canned. ..

Library of Congress
Medline Advanced [5P)
PLbMed (RLM)

‘Wweb of Sclence |I 131 .|

Yale L
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Cont....

2. Select the database that you would like to
search, and click Connect.

Click column
headings o sort
the list.

Click to search
for files.

Click to display
more or less

information about
the selected file.

&2 EndMote Connection Filos

dames |rl nmation Provedider

[ 1 Waszhingon U Litreap Cstabogs

| water Res b 054] Cambrdge Scinbhc Absdrec iz

[ wdany v Eraie L Libaap Calalge

[l eb of Scieree [1S1)

[ “w'ebs of Sci=rce &HO 1511 151

! I T O C  JO d o BN . Lul b Tad]

Find [ mskan | | Uomakas | | Bk

& Le==sInio

Fila Mame: 'Wieb of Scancs (151 Lanz
Crealed Surday, kiay 09 3000 1 0744 P

Hodified Surdap biay 09, 2004 1407:4d P
Etmzemd O
Calmgony: 151

Comnes |Sescher sl chalior rdEies on'web of Science.

Showing 431 oF 931 connechom files Fon C:Proegram FlleslEnd kbabe| Connedtiors]

30




Usually, we use
PubMed (NLM)

Choose A Connection File

Mame

Paortland 5t U
Fretdedline [0WID]
Princeton Theo Sem
Princeton U

ProQuest
PawcARTICLES [OCLC)
PzpcFIRST [OCLC)
PzucIlMFO [CS54)
PazycIMFO [EBSCO)
PawelMFO [OCLE]
PaycIMFO [0WID]
PaycIMFO [SP)
Pubkded [HLK]
Purdue U

Queen Margaret L Call

Fird

& | ezz [nfo:

File Mame: Pubkded [MLM].enz

Cont....

Infarmation Provider

Library Catalogs
Owid

Library Catalogs
Library Catalogz
ProQuest

QCLC FirstSearch
QCLC FirstSearch
CSa

EBSCO

OCLC FirstSearch
Owid

SikverPlatter

RLH

Library Catalogs
Library Catalogs

Cancel

Created: Monday, October 27, 2003, 171:08: 46 AM
Modified: Monday, October 27, 2003, 11:08:46 Abd

Bazed On:
Category: ML

-

Comments: Thig is an HTTP-based connection file for ~ +

the Mational Library Df_Medit:ine's F’u_bhﬂed

w

Showing 561 of 561 connection files from CWProgram Files\EndMote 9 Connections’



EndNote’s Search window

e When the connection has been established, an
empty Retrieved References window opens and
EndNote’s Search window appears, ready for you to
enter a search.

=13}
rch |

A Field b Containz LT Apnd s
A Field b Containz R And W
Ay Field o Contains R

Search | Femate: Pubhed MEDLIME at Pubhed (ML) -

2 Less

[ Save Search ][ Load Search ][ Set Default ] [ Restore Default

[  #ddField | [ InsettField | [ DeleteField |




Cont....

3. Enter your search request (key words) into
EndNote’s Search window, and click Search.

After establishing a connection:

A. Enter your search term(s) into EndNote’s
Search window.

B. Choose the appropriate search options.

C. Click Search to send the search request to the
remote database.



Cont...

After entering your search key words it may
seem as figure below

#] Remote Search Library Catalog (MELYYL]) At University of Califor nia
Seanch

[laz. ¥ e

|IJCI1'IEH SLADETY

|-:::-'|'-|:J-¢aln:ﬂe= Fepacid:

[Machal, Aadbor

Sesch  Remole: Lbrary Cobalog IMELY VL] ALL =
& Lexs

| SaveSeach | [ LoadSeach ||  SetDefak | | RestosDefaut |

[, addfed | [ IncetFied | [ DekteFied |
Click Add Fieid to Click and drag the corner to
append new search resize the window and view more

lines to the list. search lines at one time. 34




Cont....

4. EndNote searches the database and displays the

number of references that were found to match your
search criteria. Click OK to retrieve the references.

Canflirm Remate Search

Fourd § Fefarences Change one or both
of these numbers to
H elniesa Halerancss: Fiom: i lhaugn: & specify the range of

references to be
downloaded.

35



Cont....

5. Once the references appear in the Retrieved

References window, you may browse through them

and transfer the ones that you want to keep to your
EndNote library.

RHemote
database
name

The
retrieved -
references

#l Cannected to: PubMed MEDLINE at Pubied [MLM)

Status bar —

Dore
0 Author Year
Wan Gal. F00A
Snwanng... 2003
Lian 2002
My 2002
o 2001
Zhah 2000

insbarg 2000

Copy 6| Asfersnces To - _

Title

Cormelation of visual and ref
Internal astigmatism and its...
[An anaksis of regression ..

The role of ulremoletEin ¢

Anakang refractve changs
Laser in situ kerstomilzusis .
Effect of lamellar Aap locat .

Showria 7 odk of Tretrieved refereross .,

LRL

Ao fsnme Bl nln .
hEtp e ncbiniman. .
hEtp e ncbiniman. .
At it il nlem .
fittp it il nlem .
AEtpAfeians necbi.nlon.n.
REtpffeaanss nebl.nlon.n.

F Show Previss

Animated
logo
indicates
exchange of
information
with a remaote
database.

36




Saving References to a Library

e The Retrieved References window is a temporary
library holding for the results of a remote search.

* |t needs to be transferred to the library of your choice

— If the destination library is open, you can drag-and-drop
selected references

— Select the references that you want to save, and click the
Copy References To menu at the top of the window.

— Selected references may be copied by choosing Copy from
the Edit menu,



To Cite While You Write a manuscript

1. Open the EndNote library that contain the references you wish to
cite.

2. Start Microsoft Word and open the paper you are writing.

(it is recommend using the template wizard to create your Word
documents)

3. When you are ready to cite a source, position the cursor in the
text where you would like to put the citation.

4. Go to the Tools menu in Word, then the EndNote submenu, and
select Find Citation(s).

5. An EndNote Find Citations dialog appears, which shows the
previous search results.



The Cite While You Write Commands
a—

Endfiobe 9 k
W apeling and Grammar,., F7

Temnplates 2nd Add-[ns...

Cushomizz..,

ontions..,

Find Citadoni<y..

=0 To Endhate
Formiak Bitlioarachy, ..
Inszrt Seleched Citationis)

T s

e

3=

Edit tationis) ...

Insart Mote, ..
Edit Liorary Paferences)
Unformat Ckatianl )
Eemove Field Cod=s

g 3 35 R [

Export Traveling Library...

lig” Find Bgorals]...

Generabe Figuee List

WL cite whils You lmbe Preferances...
7 Heb

End™Noke 9 v X

QR = 2209 wiB & 7

EndMote

{:El EM Go to EndMote Style: Depression and Anxiety = | % Export to EndMote ~

=1 Edit Citation(s) E Update Citations and Bibliography 2-) Preferences
Insert i i

Citation = g,)’ Edit Library Reference(s} ['9_] Convert Citations and Bibliography = || ‘? EndMote Help
Citations Bibliography P Tools



Creating a Word Document Based on
a Template

1. Start EndNote.

2. From the Tools menu, select Manuscript Templates.



Cont....

Click the tools and select
“Manuscript template”

£l EndNote 9 - [PubMed | ' MLINE at PubMed (NLM)] =13,
File Edit References Tools Window Help - O X
=R = & 2 ] [ﬂv @‘ Depression and Anzis
th 2w
|F'u|:u|‘--1 ed server found. ..

1] Author = Year Title

b

<
F showw Preview

Showing O ouk of O retrieved references.

Ready

Tools ﬁ “Manuscript template

41



Cont...

3. In the File dialog, browse to the Templates
folder found in the EndNote folder.



Manuscript templates

Manuscript Templates

Loak. in:

-1

9

ky Recent
Dacuments

—_—

F
Deskiop

7]

My Documents

-
w38
by Computer

.

by M ebwork:

) Templates

lﬂ:JEreast Cancer Research
IEI_=JE=rit 1 Pharmacology

W Bulletin of Yolcanology

@Cancer ACS
@Cancer Cell International

@Cardiwascular Ciab
@Cardiwascular Ulkrasound

W] el

lﬂ:JCEII and Chromosorne
lﬂ:JCEII Death Different
@Chemical iGeology

@Chemistry

4

File name:

Files af type:

Bnt Medical J

@Chest

] chicaga 15th A

¥ chicaga 15th B
@Circulatinn

@Cnmp Biochern Phws
@Cnmparative Hepatology
@Cnntrib Mineralogy Petro
@Critical Care

@Current Biology
@Current Controlled Trials
IE_I:JCurrent pinion Lipid
lﬂ:JCurrent Cpinion Okalaryn
lﬂ;JCytDkine iarowkh Fack Rew

b anuzcrpt Templates]”. daot)

[ ] Open as read-only

v

?)X
s [~

@Demngraph?
@Develnpment
Developrental Bic
Earth Planet Sci L
Ecology

EMED ]

=L |Environmental He
@Eurn Physical 1<
) FasER 3

W] FEMS Micrahialog:
1] Filaria 3
@Gastmentemlngv
@Gennme Biology

EiEEE

El

>

Open |

w | Cancel |
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Creating a Word Document Based on
a Template

4. Select and open the template named for a particular
editorial style guide you intend to submit your
manuscript.

This opens a new document in Microsoft Word that is
based on the template file, and starts a manuscript
template wizard to help you set up your paper.



Example of manuscript template
(title page, BMJ)

[Insert Title of Article]

[Insert Names of Author(s)]

[Insert Affiliation information here including email addresses]

[Insert Word count for text onlv]
[Insert Name and contact information for suitable peer reviewers|

[Insert sources of funding]



Example of manuscript template
(title abstruct, BMJ)

NOTE: Abstract below should be <250 words and broken into the following sections.

Objectives [Insert Objectives here]

Design [Insert Design here]

Setting [Insert Setting here]

Participants [Insert Participants here]

Main Outcome Measures [Insert Main Outcome Measures here]
Results [Insert Eesults here]

Conclusion [Insert Conclusion here]

[Insert "What this paper adds" box which includes 2 paragraphs]

[1) "What is alreadv known on this subject?’ and 2} "What does this studv add?"]

46



Cont...

On Word 97-2003

Format bibliography Edit library references
Find citation T
Edit citation

Generate figure list
Remove field codes

: : Hel
Go to endnote Insert note Find figures P
Insert selected Unformat citation _ lh'l .
citation Cite while you write
preferences
On Word 2007
EndMote
'D.j EN Go to EndNote Style:  Depression and Anxiety 4 "' Export to EndMote =
“" Edit Citation(s) ¢= Update Citations and Bibliography 2] Preferences
Insert '
Citation = 3_/’ Edit Library Reference(s) FJ Convert Citations and Bibliography = "? EndMote Help
Citations EBibliography ] Tools

47



Finding and Inserting Citations

e This is the easiest way to find and insert a
citation into a Word document:

1. Open the EndNote libraries that contain the
references you wish to cite.

2. Open the Word document and position the cursor at
the location where you would like the citation.

3. Highlight the desired reference(s) in your EndNote
library.

4. From the Tools menu in EndNote, select the Cite
While You Write submenu and choose Insert Selected
Citation(s).



2. Open the Word document and position
the cursor

........ reported that for every maternal death in
developing countries, at least 15 other women
are incapacitated or handicapped, and about
15 million women develop long term
disabilities such as obstetric fistula, sever
anaemia, pelvic inflammatory diseases,
reproductive tract infection and infertility |.



1. Open the EndNote libraries

l#| EndMNote X1 - violence Copy Copy.enl
Fil=  Edit

References  Tools  window Help

=h = & %¢ Dﬂ '@P @’ T |Depression and Anxiety s 2 % P

—
th EE W

=4 viblence Lopy Lopy.enl

Groups figh B Author Year Title Journal Ref Type =~
All References Berhane 19399 Establishing an epidemioclogical field Ethiopian J Journal Arti

Cogneau 2003 Colonization, Institutions, and Inequal .. Electronic B
Coker 1998 Wiolence against women in Sierra Le... Afr J Repro...  Journal Arti.
Custom CSA 1994 Population and Housing Census of th... Book
Deyessa 1998 Magnitude, type and outcomes of ph...  Ethiop Med J  Journal Arti.
Ellsberg 19399 YWife abuse among women of childbe . .. Am JPubli...  Journal Arti.
Ellsberga 2000 Candies in hell women's experience Soc Sci Med  Journal Arti
Evoel 2007 Pattern of intimate partner violence a..  Gender stu Thesis
Garcia-More... 20086 Prevalence of intimate partner violen... Lancet Journal Arti.
Habte D. De... 2003 Assessment of the utilization of pre-... Ethiop.JHe... Journal Arti.
Heise 2002 A global overview of gender-basedwi... IntJd Gynas...  Journal Arti.
Hindin 2003 Understanding women's attitudes to... BullWorld ... Journal Arti.
Jewles 2002 Intimate partner violence: causes and... Lancet Journal Arti.
Jdewilcas 2002 Risk factors for domestic violence: fi...  Soc Sci Med  Journal Arti.
kim 2002 "Women enjoy punishment': attitudes... Soc Sci Med  Journal Arti. =
< >

Berhane ¥, Wall S, Kebede D, Emmelin E, Enquselassie F, Byass P, Muhe Lea. 1993, Establishing an
epidemiological field laboratory in rural areas - potentials for public health research and
intervention. The Butajira Rural Health Programme 1987-99. Ethiopian Journal of Health
Development 13:1-47 |

Showing 28 of 28 references. 2 Hide Preview

Ready ML




3. Highlight the desired reference(s) in your EndNote
library

& EndNote X1 - violence Copy Copy.enl

File Edit References Tools ‘Window Help

[ =& & &1 B @ '@r '@‘ T1 | Depression and Ansiety v 7 & ~

fis’ B Author Title Journal
Berhane 1999 Establishing an epidemiclogical field...  Ethiopian J...  Journal Arti.
Cogneau 2003 Colonization, Institutions, and Inequal ... Electronic B
Colker 1995 Wiolence against women in Sierra Le... Afr I Repro...  Journal Arti.

CSA Fopulation and Housing Census of th. .

Ellsberga Candies in hell women's experience..
Eyoel Fattern of intimate partner violence a... Gender stu...  Thesis
Garcia-More. Frevalence of intimate partner violen... Lancet Journal Arti.
Habte D. De .. Assessment of the utilization of pre- .. Ethiop.JHe. .. Jdournal Arti.
Heise A global overview of gender-basedwvi... Int d Gynae...  Journal Arti.
Hindin Lnderstanding wwomen's attitudes to...  BullVWorld ... Journal Arti.
Jewlkes Intimate partner violence: causes and... Lancet Journal Arti.
Jewlkes Risk factors for domestic violence: fi...  Soc Sci Med  Journal Arti.
kim "WWomen enjoy punishment'": attitudes ... Soc Sci Med  Jdournal Arti. =
< >

Ellsberg MCZ, Pena R, Herrera A, Liljestrand J, Winkwist A 1999 Wife abuse among women of
childbearing age in Micaragua. Am J Public Health §9(2).241-4.

Showing 25 of 28 references.

2 Hide Preview

MUM
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4. From the Tools menu in EndNote, select the Cite While You
Write submenu and choose “Insert Selected Citation(s)”.

#{ EndNote 9 - disabled

File Edit References Tools ‘Wis#iw Help

=g + 5 a4 51 il i g ) Depression and Anxiety s | 2
o= W
Orin Micrbsoft word
(0g) d Iy R ) ¢ Document2 [Comp
j/l Hame Insert Page Lyg@bhut References Mailings Review View Add-Ins

EndMote 3 -~ i

QA=A 22 R EE 7
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Final result

........ reported that for every maternal death in developing countries, at least 15 other women are
incapacitated or handicapped, and about 15 million women develop long term disabilities such as
obstetricfistula, severanaemia, pelvicinflammatory diseases, reproductive tract infection and infertility
(Deyessa et al. 1998; Ellsberg et al. 1993).

Deyessa M, Kassaye M, Demeke B, TaffaN.1998. Magnitude, type and outcomes of physical violence
against married women in Butajira, southern Ethiopia. Ethiop MedJ 36(2):83-92.

Ellsberg MC, PenaR, Herrera A, Liljestrand J, Winkvist A.1999. Wife abuse amongwomen of
childbearing age in Nicaragua. AmJ Public Health 89(2):241-4.

53



Changing output style of reference

1. Open the EndNote libraries

2. Select and click “format bibliography”
Or in Microsoft word

£l EndNote 9 - disabled a)

Toolg®Window  Help

#2000t W@

Page Layout References Mailings

File Edit References

QA=A 22 ] EE 7

Review



Cont..

Endnote Format Bibliography window appears

EndMote Format Bibliography

Farmat Bibliography lLayDut ] Instant Formatting | Libraries Used ]
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Output styles
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Eg. Change to numbered style
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Changed style

........ reported that for every maternal death in developing countries, at least 15 other women are
incapacitated or handicapped, and about 15 million women develop long term disabilities such as
obstetricfistula, sever anaemia, pelvicinflammatory diseases, reproductive tract infection and infertility
1 2.

Reference

1. Deyessa, N., Kassaye, M., Demeke, B., and Taffa, N., Magnitude, fype and outcomes of physical
violence against married women in Butajira, southern Ethiopia. Ethiop Med J, 1998. 36(2): p. 83-
92.

2. Ellsberg, M.C., Pena, R., Herrera, A., Liljestrand, )., and Winkvist, A., Wife abuse among women

of childbearing age in Nicaragua. AmJ Public Health, 1999, 89(2): p. 241-4.
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Adding the written example

........ reported that for everv maternal death in developing countries, at least 15 other women are
incapacitated or handicapped. and about 15 million women develop long term disabilities such as
obstetric fistula, sever anaemia, pelvic inflammatory diseases, reproductive tract infection and infertility
[1.2]. Asitwas discussedin the lesson; the best remedy against research misconduct lie on the scientists
themselves. The scientists should critically evaluate the research and forward the appropriate critics
without anv favoritism or preconceived notion. Sometimes this mav not be easv as it seems. The
following factors affect the judgment of the scientist: ime, culture, knowledge, relation with researcher,
etc. The otherremedyvis education of students and supervisors. If one does not have the knowledge; he
or she is verv likelv to make mistakes [3, 4]. The scientists should critically evaluate the research and
forward the appropriate critics without any favoritism or preconceived notion [3].
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92,

2. Ellsberg, M.C., Pena, R., Herrera, A., Liljestrand, J., and Winkvist, A., Wife abuse among women
of childbearing age in Nicaragua. Am J Public Health, 1999. 89(2): p. 241-4.

3. Berhane, Y., Wall, 5., Kebede, D., Emmelin, E., Enquselassie, F., Byass, P., etal., Establishing an

epidemiological field laboratory in rural areas - potentials for public health research and
intervention. The Butajira RuralHealth Programme 1987-95, Ethiopian Journalof Health
Development, 1999.13: p.1-47.

4. Habte D. DeyessaN. Davey G., Assessment of the utilization of pre-marital HIV testing services
and determinants of VCTin Addis Ababa, . Ethiop.J.Health Dev., 2003. 20(1): p. 18-23.
5. Martin, E.K., Taff, C.T., and Resick, P.A., A review of maritalrape. Aggression and violent

behavior, 2007. 12: p. 329-347.
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Changing the paragraph...

The scientists should criticallv evaluate the research and forward the appropriate critics without anv
favoritism or preconceivednotion [1]......._reported that for every matermnal deathin developing countries,
atleast 15 other women are incapacitated or handicapped, and about 15 million women develop long term
disabilities such as obstemric fistula, sever anaemia, pelvic inflammatory diseases, reproductive tract
infection and infertility [2, 3]. As it was discussed in the lesson; the best remedy against research
misconduct lie on the scientists themselves. The scientists should criticallv evaluate the research and
forward the appropriate critics without anv favoritism or preconceived notion. Sometimes this mav not be
easy as it seems. The following factors affect the judgment of the scientist: ime, culture, knowledge.
relation with researcher, etc. The other remedvis education of students and supervisors. If one does not
have the knowledge; he or she is very likelyv to make mistakes [4, 5].
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